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Visit the Flow Facility website! 
http://www2.massgeneral.org/aids/flow_cytometry.html 
It contains information about our instruments, links to calendars 
and flow resources, and many core documents, as well as a flow 
cytometry syllabus of resources to expand your flow knowledge. 

 
Please let me know if anything is not working properly or you have 
any problems with the instruments or the facility in general-- email 

mwaring@partners.org or parcfacs@partners.org 
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 Creating an Account 
 
To become a user: 

--visit http://www2.massgeneral.org/aids/flow_cytometry.html and 
read the “Welcome New Users” document linked on the main page 

--go through the introductory material on the training page (linked in 
the list on the left side of the page) 

--attend the introductory class (dates are announced on the training 
page).  There is a fee for attending the class, please provide 
information as requested on the website. 

--go through the “FACSDiva software quick start” on one of the LSR 
computers or PC analysis station (shortcut to the document can be 
found on the desktop), and go through the online DIVA tutorial 
(linked on the training page). 

--observe another person operate the instrument at least twice. 
--schedule time with core personnel for an orientation session and 

then to run at least your first experiment with you. 
-- Passing a proficiency test is required before you can run 

independently, and for the first few months limit your reservations 
to during working hours so that someone is in the lab in the event 
of some problem. 

 
Usage rates are posted on the instrument pages on the website.  For user-
run analysis, billing is tracked by how long user is logged into the 
software for Diva.  For data analysis, use the dedicated analysis 
workstations for free instead of getting charged for using the instrument 
computers. 
 

 



  

Instrument Locations 

 
The 3 Laser LSR II (“3L”) is located in CNY149, room 5227.  
Take the central elevators to the 5th floor, go through the door to 
the left of the balcony, and then go through the door straight ahead 
to enter the lab, room 5228.  Keep going straight and you will see 
the instrument against the window in the bay in front of you. 
 
The 4 Laser LSR II (“4L”) is located in CNY149, room 5556.  
Take the central elevators to the 5th floor, go through the door to 
the left of the balcony, and then go left down the hall.  The flow 
lab is on the left, look for the card reader next to the entrance door. 
Authorized users must submit their MGH ID (either the 9 digit 
number on the back of your ID, or your blue card number) in order 
to activate their ID for access to the room.  Please email the 
information to mwaring@partners.org. 
 
The 4 Laser LSR II Rental (“4R”) is located in CNY149 room 
5104.  Take the West Elevators to the 5th floor, and go through the 
door to the right of the balcony.  Go to the right, past the break 
area, and enter the door to the lab space.  Walk down the hallway, 
turn left, then left again and head towards the cold room.  Go to the 
right, and the instrument is at the end of the hallway on the right. 
  
The 5 Laser LSR Fortessa (“5L”) is located in CNY149, room 
5227.  Take the central elevators to the 5th floor, go through the 
door to the left of the balcony, and then go through the door 
straight ahead to enter the lab, room 5228.  Walk straight ahead 
and you will see the instrument in the bay in front of you.  It is the 
blue instrument on the right. 

 

mailto:mwaring@partners.org


  

Configurations 
 
The cytometer detectors are arranged in either octagon or trigon 
arrays of filters, with a separate array for each excitation line.  The 
entry point for the emitted light into the array is indicated by the 
square in the pictures below, and travels sequentially to each 
detector, first to “A”, then “B”, etc.   

 
 

 Filter choices for each detector are assigned in the Diva 
software as a “configuration”, which links the fluorochrome name 
to the detector.  It is up to the operator to make sure the filters 
match the configuration. 
 Each instrument has its own arrangement of filters, and some 
alternate configurations have been established for specific 
applications.  These layouts are presented in table form on the 
following pages.  Cells filled in yellow indicate filters that get 
changed for the alternate configuration.  Instructions for changing 
configurations can be found elsewhere in this guide. 

 



  

3L LSR II “Default” Configuration 
 

 
 
 

 



  

3L LSR II “APC Cy5.5” 
 

 

 



  

4L LSR II “Default” Configuration 
 

 

 



  

4L LSR II “Qdot” configuration 
 

 
 

 



  

4L LSR II “APC Cy5.5” configuration 
 

 



  

4R LSR II “Default” Configuration 
 

 



  

 
4R LSR II “Factory” Configuration 
 

 

 



  

5L LSR Fortessa “Default” Configuration 

 



  

 Schedulebook Calendar Instructions 
 
The resources of the Ragon Institute Flow Cytometry Facility and Imaging 

Facility, as well as some other Ragon equipment (Luminex, RT-PCR machines, and 
Robosep—email separate administrators for rules for booking this equipment, in the 
“Notes” for the resource on the calendar) are reserved using the online calendar system 
“Schedulebook”. New users must request a user name and password to be able to book 
time on the calendars. Email mwaring@partners.org with the instruments you wish to 
have access to. 

There is a guest account available for viewing the calendars (but you may not 
reserve time using the guest account).  Username is “flowguest” and password is “flow”.  
You will NOT be able to book time with this account, only view the calendars. 

 
I. Calendar/Reservation restrictions for cytometers 
II. Usage instructions/tips 
III. Ragon Institute Members---booking “Ragon” reserved time 
IV. Standby Events 
V. Administrators 

 
I.  CALENDAR/RESERVATION RESTRICTIONS FOR CYTOMETERS: 
 The following restrictions are in effect for booking time on the cytometers.  For 
rules governing use of the other equipment, please contact the appropriate administrator 
as found in the “Resource Notes” for each device (the “N” button next to the device’s 
name in the calendar). 
 

1.  Users that are not members of the Ragon Institute may not book time more than 1 
week in advance. 

2.  Do NOT book time that already shows a reservation in “standby” (narrower dark 
blue column to the right of the reservation column). This time should be considered 
“booked” (see section IV below). 

3.  Reservations between 12 PM and 9 PM are limited to 2 hours in duration, and no 
more than 2 reservations per week can be made between 2 and 6 pm. 

4.  Tuesday, Wednesday, and Thursday afternoons from 3 to 7 are reserved for 
members of the Ragon Institute, and unreserved time is released to the rest of our 
users on the day before the time slot.  For Ragon members, see Section III below 
for guidelines on booking time during these hours. 

5.  Sorting times on Tuesday and Thursday afternoons from 2:30 to 4:30 are reserved 
for members of Ragon Institute, and released on the day before the time slot.  Grey 
areas of the calendar are NOT available for booking. 

6.  If you decide to not use your time or will not be using the entire time reserved, 
please update or delete your entry as soon as possible so that other researchers will 
know it is available for use. 

7.  If you fail to delete your unwanted reservation at least 1 hour before the start time 
and do not use your time, you may still be billed for 1 hour usage. 

8.  If you do not arrive for your reservation within 20 minutes of the start time, anyone 
else can use the instrument and you forfeit your reservation. 

 



  

 
 
II.  USING THE CALENDAR PAGE 
 Once your new account is created, you can go to www.schedulebook.com and enter 

your login information in the fields on the right side of the page.  If you are a sort 
only user, or don’t yet have an account, you may log in with the Guest account, 
username “flowguest” and password “flow”. 

 There is a help menu, with a contents file that describes all of the features of 
Schedulebook. The basic controls have been summarized below, but this file is 
available for clarification. 

 When you log in for the first time, all of the resources will be visible, but you will 
only have reservation privileges on the ones you requested.  Only Administrators 
have reservation privileges on the sorting calendar—see the sorting guidelines for 
details. 

 If you scroll over “tools”, a dropdown menu will appear, with options for “New 
Event” (“sort only” or guest users will not see this option), “Search/Export”, and 
“Personal Settings”. 

 Select “Personal Settings” and add an email account. Under “Visible resources”, 
everything will be highlighted. Click on an item to select it, and then hold <control> 
and click to select multiple items at once (Mac users hold the <apple> key). These 
will be the resources you can see on your calendar page. This does NOT grant you 
privileges to reserve that resource, only to view it. For sorting and for Mike’s 
calendar, you can select these items as visible, but you will NOT be able to make 
reservations—you must still email sort request forms to ragonfacs@gmail.com, or 
make arrangements to book training, instrument orientations, etc. 

 The “Start time” and “end time” visible on this page refer to the displayed times on 
your calendars. If you will be booking time outside of the displayed window, you will 
need to adjust the times to view the other hours of the calendar. Modify the other 
preferences as you prefer. You can also change your password here. 

 Under the “View” pulldown menu, you can change the calendar view. From the 
monthly view, you can switch to previous month, next month, or current month. By 
clicking on the number for a given day, you will switch to the daily view. 

 When in the day view, you can go to previous date, next date, today, tomorrow, pick 
date (a popup calendar appears that you can click the desired day), and month view, 
which takes you back to the monthly view. 

 There are also buttons on the top right to change the display date, the arrows advance 
day by day, or “pick date” will open a popup calendar to help you navigate to the date 
of interest. 

 Selecting “Tools>New Event" or clicking on the “New Event” button on the top right 
will open a dialog window with a pull-down list of what resources you have access to 
and are set to “visible”. If any instrument you need access to is missing, let me know 
and I will add it (make sure the desired resource is set to “visible” in “Tools>Personal 
Settings”). The date for the event will be whatever date was displayed when you 
chose "new event". You then choose a start time and end time, and type in any notes 
to create your event. Please include your telephone number as a "note". 

 



  

 When you make a reservation, your display name will show on the calendar, and if 
there is an email address associated with it you can click on the name to send an 
email. If there was a note entered, it will display in a popup window if you click on 
the green "N". The "E" allows you to edit the reservation, and "D" will delete it.  If 
you do not have those privileges (i.e. someone else’s reservation) they will not show 
up as options. 

 The wider column under each resource is the primary schedule, and the narrow 
column to the right is for events on “Standby” that overlap with another event (see 
images in section IV).  Please do NOT book time that is already covered by a standby 
event, even if it is free on the main calendar, as this time should be considered 
reserved.  I receive email notices of when each modification takes place, so I will 
know who actually booked the time first. 

 Each resource can have a resource note associated with it, which appears at the top of 
the column next to the resource name as an “N” button. When it is red, it has been 
changed since you last viewed it. When it is green, you have already seen it. 
Resources also have Alerts, which will open a popup window when you attempt to 
make a reservation on that resource. This will contain messages about instrument 
down times, etc. The “!” next to the name of the instrument is a problem notification 
address, click on it to report a problem with the resource, and an email will be sent to 
the appropriate administrator. 

 
 
III.  Ragon Institute members 
When booking time that is saved for the Ragon Institute, you can do it 3 ways: 
 

1. Log in as the Ragon Institute (email Mike for the login info) and modify the 
reservation to free up the time you want to book.  Then log in as yourself and 
book the time. 

2. Log in as yourself, and when you book the time that overlaps with the Ragon 
Institute, be sure the check the button under the “notes” that says to book the 
reservation as a “Standby” event if there is a conflict.  I then go through a few 
times a day and update the Ragon booking to free up the time and allow the 
standby event to take over the primary spot.  Until your “standby” event becomes 
the primary event, it is possible for someone else to book the “primary” 
reservation—i.e. the Ragon event is from 3-7, if you book from 2-4 then your 
entire reservation will be put on standby, and it would be possible for someone to 
book 2-3 before I have had a chance to edit the Ragon event to make the standby 
reservation into the primary one (see section IV below).  So, the 3rd option: 

3. Book the time that overlaps with the Ragon reservation as standby, and book the 
open time as a normal reservation.  In the above example, book 2-3 normally, and 
designate 3-4 as a “standby” event, so that no one tries to reserve your time. 

 
 
 

 



  

IV.  “Standby” Reservations 
 
There is time reserved for the Ragon 
Institute from 3 to 7 on Tuesday, 
Wednesday and Thursday each week.  
Unreserved time is made available to the 
general public on the day before the 
event and can be booked by anyone.   
 
 
 
 
 
 
 
Sometimes when this time is reserved by Ragon members, it is booked 
in “Standby” which appears as a darker column next to the main 
reservation column.   
 

 
 
 
 
 
 
In the Schedulebook software, it is possible to still book time 
overlapping with the “standby” event.  Please consider the “standby” 
time as taken, and do not encroach on this event—if there is a conflict, 
the core receives notifications of any changes to the calendar and I can 
determine who actually booked the time first—but I’d rather not have 
to play detective. 
 
 

 



  

V.  For Administrators: 
--Please update the resource you are responsible for-- add notes with any contact info and 
any links etc that apply, and if there are outages etc please add a resource alert, if you 
have questions about these features check the "help" menu on Schedulebook. 
--When adding a user, please use the full name for "display name", no nicknames and 
make sure last names are included.  
--Before adding a new user, check to see if the user already has an account for another 
device.  
--When adding access to a device, hold control (or apple on mac) so that you don’t de-
select resources that were given access previously. 
--If you need to create a new device, use the "no users have access to this device" as the 
default, otherwise EVERYONE will end up with access to it.  This defeats the purpose of 
having access restricted. 
--Keep the names short (for devices and users).  
 
 

 



  

Core Usage Rules and Penalties 
 
Calendar usage: 
--Calendar bookings are limited to 2 hours in length between 12 pm and 9 pm, and no 
more than 2 bookings per week between 2 and 6 pm.  Non-Ragon users may not book 
time more than 1 week in advance, and Tues, Wed, and Thurs afternoons from 3 to 7 are 
reserved for Ragon users until the day before, when unclaimed time can be booked by all. 
 
***Violations of these limits will result in warnings for the first 2 occurrences, and a 1 
week ban from reserving instrument time on a third offence.*** 
 
Data Storage Limits: 
--Data storage is limited to 2 experiments in Diva and nothing older than 2 weeks, and no 
more than 3 GB in the personal D drive folders.  To avoid excess data in Diva, the core 
exports data as an experiment into users' D drive folders, into a new folder labeled 
"experiments mmddyy".  Users are responsible for checking these folders to see if they 
need the data and storing or deleting as appropriate.  These folders should be removed, 
and storage on the D drive should be minimized. You will be warned when your folder 
has exceeded the limits either by email or being listed on the dry erase board near the 
instrument. 
 
***Habitual abusers of storage space will be issued a violation.   A second violation will 
be issued if no action has been taken, and a 3rd violation will result in your access being 
blocked until it is reduced.*** 
 
Instrument Usage: 
--If you are the last user after 5PM (“after hours”), it is your responsibility to make sure 
the instrument is turned off at the end of the day.  If you cancel on the day of your 
reservation and were the last user, you must make sure that the user before you knows 
that they need to turn it off, and all users should check the calendars when they are done 
to verify there is a reservation after them.  The core receives notices when events are 
booked or cancelled so the timing of any changes can be verified. 
--All users are responsible for making sure the tank levels are adequate for use before and 
after your time, and that instruments are kept in good condition (no broken parts, etc).   
 
****Any misuse of the instruments will result in a warning for a first offense, a 1 week 
ban for a second offense, or a 1 MONTH ban for a third offense.**** 

 



  

Using the Instruments 
 

--All human samples must be fixed, and no radioactive samples 
can be run at any time. 
A protocol is in place so that noninfectious unfixed human cell lines may be 
run after proper instruction from core personnel. 
--Gloves should be worn at all times while using the instruments and the 
computers connected to them. 
--Start up the instrument by pressing the green button in the lower right 
corner.  Make sure the computer is on.  There is no special order that needs 
to be followed when turning on the instrument and workstation.  Log into 
the computer with the username and password posted on the instrument, and 
open the Diva software by double clicking on the icon on the desktop.  It 
takes several seconds to start, if you get impatient and click it again, it will 
crash and give an error message.  Clear the error and then double click and 
WAIT.  Each user or lab has their own login. 
 
 
 

Checking the sheath tank 
 
 The sheath tank is kept on a digital scale to make it easier to 
determine the fluid levels.  The scale has an auto shut off feature that can be 
disabled by holding the lb/kg button when you turn it on.  If the scale reads 
anything besides 0 when the tank is removed from it, press "zero/hold" to 
reset it to 0.  The different sized tanks have their capacities indicated on the 
scale readout.  If the tank is less than half full, you should refill them. 
 To fill the sheath, disconnect the opaque green air line from the tank 
by pressing on the metal tab on the connector.  Do not disconnect the clear 
sheath line as this will introduce air into the sheath path.  Unscrew the black 
handle until it slides up and down, and then lift the round vent valve to 
release the pressure (the lid should drop into the tank), and remove lid.  
Make sure the black o-ring comes out with it—it sometimes sticks to the 
tank, and will sink if it falls into the sheath fluid.  Remove the sheath filter 
from the holder attached to the leg of the table and lay it on the floor.  
  Carefully keeping the tubing/connector away from the sheath cube, 
fill tank with sheath fluid from white box up to weld seam inside tank (about 
2 inches from top).  Make sure black o-ring is still seated around lid, and 
cover tank. Reconnect air line to tank.  Replace the tank on the scale. 

 



  

 Debubbling the sheath path should be done EVERY time you start up, 
in case the person before you did not do it or air has leaked into the lines, 
and requires the instrument to be turned on.  Holding the body of the bubble 
filter, tap the BODY of the filter against the table and/or tank to get air 
bubbles to collect at the base of the bleed line then expel the air by releasing 
sheath fluid into the plastic bottle on the table.  Do not hold by gray stem 
while tapping or filter will break off.  Repeat as necessary.  Bleed second 
roll clamp on side of instrument to remove air between filter and 
instrument—start stream flow, then pinch down to stop and start stream a 
few times to dislodge bubbles that may get caught on connectors.  Then 
allow to drain for 8-10 seconds to ensure all air is removed.  Observe the 
junction where tubing enters the instrument—if you see air there, contact 
Adam or Mike to purge the system. 
 
 
 

Waste Handling 
 
 Biohazard box is for biohazardous materials ONLY (samples, gloves, 
etc.)  ALL gloves and sample tubes go in the biohazard boxes.  Empty glove 
boxes and other trash can go in regular trash can.  There is a cardboard box 
for recycling white paper. 
 Due to the presence of paraformaldehyde in the fixed samples that are 
run on the instruments, all waste is collected for pickup, and does NOT go 
down the sinks. 
 Used sheath fluid and sample that has been run is deposited in the 
plastic carboy under the table.  Bleach is added to the bottom of the tank to 
produce a 10% solution when the tank is full, inactivating any potentially 
infectious materials.  A length of tubing is connected to the quick disconnect 
fitting on the cap to ensure waste is deposited directly into the bleach, and a 
filter is built into the cap to remove any aerosols from the air that is 
displaced from the tank as liquid is added.  Be sure to verify that the filter is 
in place while the instrument is running. 
 When the liquid level in the tank reaches the "full" line drawn on the 
side, please swap the tank for the empty one nearby by doing the following: 
 Make sure the instrument is in "standby" mode with a tube of water 
loaded on the sample loading port and the arm centered.  Disconnect the 
black electrical connector by turning 1/4 turn counterclockwise, and the 
orange waste line by pressing the metal tab.  Unscrew the sealed cap from 

 



  

the empty tank and transfer the waste cap to the empty tank, being careful 
not to drip waste from the sensors and tubing on the underside of the cap.  
Cover the full tank and set aside, and then reconnect the empty tank to the 
instrument. 
 Waste is collected in a 30 gallon drum that is kept in 5227.  Core 
personnel will empty the tanks into the drum.  If we are not around and both 
carboys are full, please wear a lab coat and use the funnel to transfer the 
waste to the drum, and replace the cap on the drum when you are done.  
Also remember to add bleach (kept on the floor next to the drum) to the 
empty waste container so there is about 1" of bleach in the bottom of the 
tank.

 



  

Laser warm up times  
 
Below are plots of signal over time while running a rainbow bead, showing the warm up 
time required for each color laser.  Samples should only be run when the laser power (and 
thus generated signal) is stable. 
 
3 Laser LSR II  
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4 Laser LSR IIs 
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5 laser LSR Fortessa 
 
 
 
The cube lasers used on the 
Fortessa warm up quickly, so 
that by the time you are able to 
log into the software they will 
be ready to go.  UV is the only 
one that will only turn on when 
Coherent Connection is 
running, the others will turn on 
when the cytometer is on, but 
they can be turned off in CC.  
These plots were generated by 
turning the lasers off in CC, 
booting up Diva, and then 
turning on the lasers and 
starting acquisition.

 



  

Sample Injection Probe (SIP) and Droplet 
Containment Module (DCM) 
 
 The port where the samples are loaded consists of a sample probe and 
a lever with a black knob which is called the "tube support arm".  The metal 
tube that is visible is actually an outer sleeve covering a thinner tube that 
delivers your sample to the flow cell.   The outer sleeve and tube support arm 
are part of the Droplet Containment Module (DCM). 
 In normal operation, the tube support arm is positioned to either side, 
and a tube is loaded on the sample port.  There is a black ring around the top 
of the probe (BAL seal) that holds the tube in place, and when the arm is 
centered, the tube is pressurized.  Tubes should be inserted or removed 
vertically without any pressure side-to-side so that the instrument is not 
knocked out of alignment.  Push the tube all the way up on the probe:  the 
top of the tube should touch the flat part above the BAL seal, and the metal 
probe should be in the very bottom of the tube.  Center the arm to turn off 
the vacuum and pressurize the tube.   If the seal is insufficient to hold the 
tube on the sample probe (see next paragraph), the arm is there to catch the 
tube before it falls on the benchtop and spills.  It is NOT intended to hold the 
tube on, and the black knob should NOT touch the tube during operation. 
 If the tube does not stay on the sample probe on its own, the seal may 
be wet (wipe it off with a kimwipe), the tube may be cracked or worn 
(transfer sample to a new tube), or the seal may be worn (notify someone in 
the core to replace it). 
 While the instrument is on "run", sheath fluid is being supplied to the 
flow cell under pressure.  If there is no sample loaded on the sample port, the 
sheath fluid would flow out through the sample probe and drip.  The 
instrument is engineered with a DCM to prevent this from happening.  When 
the Tube support arm is to the side, it turns on a vacuum that is connected to 
the outer sleeve of the sample probe, which aspirates the sheath fluid away. 
(see figure A on the next page--sheath backflushing through the probe in the 
center, being aspirated by the outer sleeve).   
 When a tube is loaded and the arm is centered, the vacuum is turned 
off and  pressure is applied to the sample tube, driving sample up the sample 
probe and injecting it into the flow cell (see B--tube loaded on the probe, 
sample running up into the flow cell at the top).  Note that if a tube is loaded 
and the arm is to the side, there is no pressure applied to the tube and the 
vacuum will aspirate your sample directly to the waste! 
  

 



  

           
 
 Immediately after removing your sample tube, there is still sample in 
the sample probe (C--sample probe with sample still in the tube), so it is 
necessary to wait 10-15 seconds to allow the sheath fluid to backflush 
through the sample probe and wash out the sample to avoid carryover to the 
next sample (D--clean sample probe).  Cells usually don't stick to the outside 
of the probe, but beads tend to stick more so when running beads, or for 
extra precaution (if you just ran a positive control and you are looking for 
rare events), you could load a tube of water briefly or wipe gently with a 
kimwipe to make sure the outside of the probe is clean.  This is also a good 
idea if you are swapping your controls repeatedly and rerunning them, or 
you will likely see events of the wrong color appearing in your control 
sample files when you finally record them. 
 Please pay attention and take note of anything unusual that happens 
while running your samples.  If the SIP drips while the arm is to the side, the 
vacuum line is likely clogged and we will need to be notified so that it can 
be cleared.  Likewise, if you are cleaning the instrument and notice the tube 
FILLING while the arm is to the side, this is another indication of the same 
issue. 

 

 



  

Changing Configurations 
 
 Each laser on a cytometer has its own array of filters and detectors for 
measuring the signals generated.  Which detector to use for each reagent is 
mapped out within the Diva software and is stored in a Configuration.  
Filters can be changed to match the requirements of your experiments, and 
new Configurations need to be generated to reflect these changes.  Make 
sure your colors are represented on the configuration and the correct 
configuration is active. 
 At the front of this manual are the different configurations currently 
available on the LSRs. Determine which configuration (filter setup) is 
correct for your experiment and verify that the filters installed in the detector 
arrays match those in the Configuration diagram.  Filters highlighted in 
yellow show which ones need to be changed from the default configuration 
in order to match the alternate configurations.  Filters should be inserted 
with the bottom of the label facing the center of the array, and filters that are 
removed from the default configuration can be placed upside-down on top of 
the array to make it easier to locate them and identify what filters have been 
changed when switching back to default. 

Just as important as verifying the filters is when you log into the 
software, it will display in the header which configuration is active:  if this 
does NOT match the configuration you need to use, you must switch 
configurations.  Under the "Cytometer" pulldown menu, select "View 
Configurations", and then choose the one from the list that you need to use, 
and click "Set configuration".  Close the CST/Configurations windows and 
return to Diva.  Verify the proper configuration is displayed in the header. 
 On the front of the instrument is a card that says “Default 
configuration” on one side and “configuration has been changed” on the 
other.  Be sure to flip this card if you change the configuration.  In the event 
that you forget to switch the filters back, this will notify the next user that 
the filters have been changed and they can correct the setup for their 
experiment. 
 
 “CST” or Cytometer Setup and Tracking, is a QC protocol that sets 
proper laser delays and area scaling, and tracks instrument performance to 
give early warning of problems arising.  We only run setup on the default 
configuration, so that is the only configuration with the correct settings.  
When you change the configuration on the LSRs, it is important to take the 
following steps to make sure the proper "CST" settings are applied.: 

 



  

 a.  When you first log into Diva, make sure the "default" configuration 
is the active configuration. 
 b.  ONLY accept "use CST settings" when the Default configuration 
is active. 
 c.  If using a different configuration, select "Keep current settings" 
AFTER accepting the settings from "default".  If you select “keep current 
settings”, the following errors will appear in the cytometer window.  You 
can just ‘clear’ them.   
 
 

  
 
 To make sure your settings are correct, make sure the “default” 
configuration is active, log out and then log in again and choose “Use CST 
settings” if the CST mismatch dialogue box appears.  If it does not appear, 
then your settings match CST and you may proceed. 
 If you want to see how different the settings are, select "details" when 
you get the CST mismatch dialog window.  Some of the out of date 
performance checks for the alternate configurations will be WAY off. 
 

To change configurations: 
1. From the cytometer pulldown menu, select CST.  Verify that cytometer 

baseline and cytometer performance have passed and are up to date for 
your configuration. 

2. To select a different configuration from the default, click Select 
Configuration, pick out the configuration you are going to use and click 
Set Configuration. 

3. During your first time checking CST, it will say everything has failed 
until you select a bead lot.  Select the appropriate bead lot from the Lot 
ID menu.  Now verify the cytometer performance is passed and up to 
date. 

4. If the performance is listed as out of date or failed, please see Mike or 
Adam. 

 



  

 
This is what a passed CST window should look like  

 



  

Miscellaneous Tips and rules: 
 
--No unlabeled tubes should be left on the desk.  Please throw away any 
unlabeled tube you find. 
--Fresh cleaning tubes should be made weekly. 
--Label all tubes. Do not overfill (no more than 2/3 full) 
--Don't let a tube run dry,  
--Don't leave a sample tube on while tube support arm is to the side as your 
cells will be aspirated directly to waste 
--Filter samples especially if there might be large clumps of cells. 
--Recommend that you run water before you run your samples. 
--There is a “sample fine adjust” knob, which allows the operator to set 
event rate to any level instead of just 3 fixed rates.  (Lo flow rate with knob 
all the way clockwise is faster than Med flow rate with knob all the way 
counterclockwise). 
--full standby (button), stops sheath fluid flow to conserve sheath.  Use only 
when done, and always load water tube while instrument is in standby—
while running samples, leave instrument in “run”.  
--PRIME:  flushes the flow cell, refills with sheath--clears air bubbles (like 
when you let sample tube run out).  May eliminate noise.  Always remove 
tube before priming!

 



  

Tips and procedures specific to the 5 Laser LSR Fortessa 
 
1. “Coherent Connection” is a program that allows you to control the power output 
of the lasers on the system, and is started using the shortcut on the desktop before 
opening Diva.  Please wait until the instrument connection is established before trying to 
open the software. 

   “Disconnected”       “Connecting”      “Connected” 
 
All 5 lasers should have a window displaying the power setting and output as shown:  
  

 
These should not be changed but can be used to see laser status for certain problems. 
 
 At times, errors will occur when the program is loading, most often if you try to 
open CC before the instrument connection has been established—this is a known issue, 
and there is no other fix at this time other than the following: 
--If either the blue (488) or green (561) lasers are not showing, use the “Tools” pulldown 
menu and select “serial settings” and then click the button to “scan ports”, and the laser 
controls should appear again. 
--If the UV controller is missing (it will sometimes disappear during the course of the 
day—this does not mean the laser is off, just that you cannot change the settings.  You 

 



  

likely will still get signals from the UV laser channels) it is necessary to restart the 
computer to get it back, just restarting the CC program does not restore it. 
--If the software gives you an “unhandled exception” (I’ve only seen it for the red laser), 
the instrument most likely was not connected when the software was started.  Quit and 
restart CC making sure the instrument is connected.  If that does not restore the slider, 
then restart the computer, make sure the instrument connects, and then open CC again. 
 
  
2. Allow to run for at least 1 minute after 
priming before running samples—priming 
clears the waste lines of liquid, and the stream 
runs faster until it fills again (air offers less 
resistance passing through the connectors, 
once liquid is going through the stream slows 
down again from the back pressure).  The 
system was aligned with the waste lines filled 
which is the normal operating mode, so when 
it runs fast the computer misses the green laser 
signals and all events will read as negative, 
and then once it fills again signals will come 
back to normal.  This can be observed in any 
plots with signals from the green laser, all 
events will be negative and then gradually 
increase to a final high intensity, and if a time 
vs green parameter dot plot is created, the 
gradual increase can be observed.  Make sure 
signals are stable before recording.  The other 
lasers will also be affected, but to a lesser 
degree and will recover faster since they aer 
not as far from the blue trigger laser. 
 
 

 



  

 
3.  Like the 3 Laser LSR, Diva will take longer to start up as it looks for the HTS (High 
Throughput Sampler).  It will give a “fluidics” error message, which can be ignored. 
 
4.  A few times in May/June 2010, the blue laser shut off during the day.  The issue 
stopped but if you lose all events and have no signals, check Coherent Connect and make 
sure the blue laser is still “on”.  If not, turn it back on and everything should work. 
 
5.  The 5 laser LSR Fortessa runs Diva 6.1.3.  Experiments created in this version cannot 
be opened in 6.1.2 so make sure you have the current version installed if you want to use 
Diva on a different workstation. 
 
6.  Keep in mind that PE and its tandems are detected off of the Green laser, but will still 
generate significant signals off of the blue laser.  For this reason, it likely will NOT be 
possible to run PE-Cy5.5 and PerCP-Cy5.5 at the same time, even though they are 
measured in different channels.  PE-Cy5.5 will still produce signals comparable to what 
is generated on the other LSRs on the Blue laser, so there will be so much signal in the 
PerCP-Cy5.5 detector that you likely will not be able to distinguish signals.

 



  

Running Unfixed Human Cells 
 
Unfixed human cell lines (NOT primary tissue samples, even from "healthy 
donors") may be run on the 4 laser LSR2.  A sign must be placed on the 
door, and the door locked to prevent entry while samples are run.  Operators 
must wear a NIOSH N95 respirator, and wipe down the work area with 
ethanol after running samples. 
 
--a particulate respirator must be worn at all times. 
--Cover the card reader with the orange "biohazard--no entry" sign 
--ALL TUBES MUST BE COVERED WHILE VORTEXING 
--run 10%  bleach when finished running your samples before doing the 
usual cleaning 
--Make sure the acrodisk filter is in place on the waste tank. 
--spray down work surfaces with ethanol when finished running samples 
--a disposable lab gown must be worn and then discarded after completing 
the decontamination. 
 
In order to wear a respirator, a form must be filled out ("Respirator 
authorization form") and faxed to OHS at 4-3944.  In addition, a fitting must 
be scheduled with the Safety office by calling 6-2425.  Contact Mike Waring 
for details and a copy of the form (mwaring@partners.org) 
 
 

 



  

LSRII / Diva Startup Guide 
If necessary to log into Windows, the username is "Adminstrator" and the password is 
"BDIS" on all core instruments. 
1.   Open FACSDiva software.  Log-in to your profile.  
 
5. If CST Mismatch dialogue appears, you should usually select “Use CST Settings”.  

See “Changing Configurations” for the exceptions. 
 

 
 
 
  
6. Click the “New Experiment” button to start a new experiment (brown square at top of 

Browser window).  Rename experiment. 
 
7.  Highlight “Instrument Settings” and in 

the Inspector window you will see each 
detector listed, identified by the 
associated reagent that comes first 
alphabetically.  Dyes occupying the 
same detector can be found in the 
configuration tables.  New users may 
find it easier to delete all of the 
parameters and add them in one at a 
time, selecting their desired labels from 
the full list that will display for each 
added parameter. Delete unwanted 
parameters and/or switch default 
parameters to the labels in your 
experiment (i.e. Alexa 488 to GFP). If 
the reagent you wish to use is not listed, check the other configurations or talk to core 
personnel to have them added (if compatible).                                                           

8. If you wish to use optimized settings, verify that cytometer settings are linked to CS
The cytometer settings icon should have a ball in the upper righ at n  

that CST settings have been applied to the cytometer setup. 

T.  
t corner indic i g

 
- If not, right click Cytometer Settings and select Link To CST.  These settings w
give you the best resolution of dim signals b

ill 
ut may not be appropriate for bright 

signals!  This will be verified in 12 below. 

 



  

 
9. Create Compensation Controls under Experiment > Compensation Setup. 

 
 
 
10. Load unstained control and set voltages so that your particles are on scale in 

FSC/SSC.  Note CST settings are optimized for BEADS, and cells will usually 

to run each of your single stain controls on the unstained worksheet 

PE-Cy5 
signal in PE-Cy5 is higher than in 

 
 

for all fluorescence parameters.   

tained control or else you will have to go back and re-record every control 
again. 

 
 Apply To All Compensation Controls after positioning it for the unstained 

e.  
ut it is a good idea to 

double check and make sure the correct peak is selected. 
 

require dropping FSC voltage 200-300 V. 
11. It is a good idea 

and verify that: 
1 – none of the signals are off-scale 
2 – signal in the primary detector is brighter than in all the others.  (e.g.  

APC).  Adjust voltages as necessary. 
 
12. If not using CST settings, adjust 

fluorescence voltages so that the tail 
of the negative peak is at the end of
the second decade on the log scale

 
13. Do NOT change voltages for any 

parameter at any time after recording 
the uns

   
14. You can avoid moving the P1 gate for every sample by right-clicking the P1 gate and

selecting
control. 

15. Record single stain controls.  Make sure the positive peak is selected for each tub
Software should adjust the interval marker automatically b

 



  

16. Calculate Compensation by selecting Experiment > Compensation Setup > Calculate 
Compensation.  You now have 2 options: “Apply” will copy the compensation to 
your experiment.  “Link and Save” will link the compensation settings to the 
experiment and save the compensation setting in the compensation setup catalog.  If 
you choose to Link and Save make sure you rename your settings (initials and date 
usually work best) before saving.  A chain on the cytometer settings indicates that 

your compensation settings have been linked ( ).  If you duplicate an experiment 
that has been linked to a compensation matrix, even if you re-run compensation it will 
be locked into the previous matrix--you must first unlink the experiment from the 
previous settings.  To unlink, right click the Cytometer Settings below the experiment 
name and select Unlink. 

17. Create a new Specimen by clicking the New Specimen button.   

18. Create New Tubes as needed by clicking the New Tube button  or clicking Next 
on the acquisition dashboard as needed.  “New Tube” will generate an unlabeled tube 
defaulting to 10,000 events.  “Next” will duplicate labels and options of the previous 
tube.   

 
19. Click “Acquire” in the Acquisition Dashboard and verify that the signals are stable 

before clicking “Record” to record your data.   
 
20. Perform shutdown procedure (see below, or back cover of hardcopy binder). 
 
21. Leave the instrument in standby, with water tube loaded and approximately 1 cm of 

water in the tube.  If no one is signed up after you please shut the instrument off.  
Please remove trash: leave it as you found it (or better!). 

 



  

 

Summary for using LSRII  
 

1. Turn on cytometer before using according to the warm up times. 
2. Check sheath and waste, fill or change as necessary 
3. 5 Laser only:  when cytometer has connected to computer (icon in taskbar at 

bottom of screen), start Coherent Connection software. 
4. Verify configuration (filter setup). 
5. Log in.  Create new experiment or duplicate existing template or import template 
6. Rename experiment.  If template, skip to 9. 
7. For New Experiment, choose parameters (colors). 

a. select “instrument settings”, and view list in “inspector” window 
b. highlight unwanted parameters, and click “delete” button in window to 

remove 
8. go to Experiment>set up> create compensation tubes 
9. run unstained cells in order to set FSC, SSC, and negatives for all parameters 

a. click acquire but not record 
b. adjust voltages as necessary 
c. depending on your panel, additional voltage adjustments may be required, 

see "Optimizing Setup of LSR" below. 
10. Run unstained beads 

a. Click acquire 
b. Move FSC/SSC gate to where beads are, or adjust voltages if necessary 

(ONLY for FSC and SSC). 
c. Right-click on gate and “apply to all compensation tubes” 
d. Click record 

11. click NEXT 
12. Instrument will display what tube it wants to record next (follows order of 

parameters in the list) 
a. Do NOT change voltage after unstained tube has been acquired.  If it is 

necessary to do so, you will have to re-run all samples. 
b. Click record. 

13. When recording is finished, repeat 11 and 12 for each color. 
14. set gates for positive populations (do not need to set gates for negatives) 

a. If you are using a mixture of sample types for compensation controls (eg. 
GFP cells and beads for other colors) you must define a negative 
population that matches the particle for the positive.  If you run beads for 
the negative, you must draw a negative gate in the GFP cells control 
sample (and have negative cells in the sample!). 

15. go to Experiment>Set up> calculate compensation.  Choose "Apply only".   
16. create new specimen.  Will contain new tube.  Rename tube 
17. Click on acquisition pointer to left of tube. 
18. Go to Experiment>layout and name the colors (i.e. CD3-FITC) 
19. click on button in upper left of worksheet window to change to global sheet.  

Whatever tube is active (green acquisition pointer) will be displayed in plots 
created on this worksheet.  Create desired plots. 

 



  

a. Draw in gates 
b. Right click on margin of graph, choose SHOW POPULATION 

HIERARCHY to see how populations are related 
c. on subsequent plots, right click margin of graph and select "SHOW 

POPULATION" and select gate/region you wish to display 
20. change EVENTS RECORDED in acquisition window. 
21. Load tube, click acquire.  If all looks ok, click "Record" 

a. Will stop automatically when target # of events is reached. 
b. To stop recording before target number, click record button again- will 

save data acquired so far. 
22. click  NEXT TUBE to go to or create next tube, rename it, and return to #21. 
23. When last tube is finished, turn off acquisition by clicking “Acquire” (will stop 

automatically if target # is reached). 
24. Clean instrument (see "Shutdown Procedure" on p 41 or back cover of binder): 
25. right click on experiment name to “CLOSE EXPERIMENT” 
26. Export FCS files—highlight experiment name, File>export>FCS.  Be sure to save 

to your personal folder on the D drive and NOT to the BDExport folder. 
27. Exit Diva. 
28. Burn files or transfer over network.

 



  

 
 

Doublet Discrimination 
 

1. Turn on FSC Height and Width and SSC Height and Width when selecting your 
parameters.  

 

 
 
 

2. Gate on your population of interest in the FSC-A vs. SSC-A plot like normal.  In 
this example we are gating on lymphocytes. 

 

P1 
P2 

P3 

3. View the lymphocyte population (P1) in the FSC-W vs. FSC-H plot.  Gate on the 
bulk of the population, ignoring the doublets tailing off to the right that have 
higher width signal. 

4. View the FSC discriminated doublets (P2) in the SSC-W vs. SSC-H plot.  Once 
again, gate on the bulk of the population, ignoring the doublets with high width 
signal off to the right. 

 



  

5. P3 will be your population of interest with the doublets gated out. 
 
 It is also possible to use a FSC-A vs FSC-H plot, and gate on the events along the 
diagonal for your single events.  On the LSR, usually gating on FSC is sufficient to 
remove doublets (on the sorter, both FSC and SSC should be used). 
 
"Wersto et al. 2001. Doublet Discrimination in DNA Cell Cycle Analysis. Cytometry 
46:296" 
 
From the Purdue Message Board: 
 “You should always use DNA area for the DNA histogram because total 
 fluorescence is what you want to measure.  You can then use either peak (height 
 on the DIVA) or width as the other parameter to give doublet discrimination. I 
 give a short explanation in my book in Chapter 6, DNA Analysis, available for no 
 charge at http://flowbook.denovosoftware.com/. 
 
 Regards, 
 
 Michael Ormerod,”

 

http://flowbook.denovosoftware.com/


  

 

 
Backgating 
 
Sometimes it is a good strategy to make sure that your cells of interest appear where you 
expect them to on plots earlier in the gating tree, to make sure that you are not 
accidentally clipping the population (for example CD8 cells typically have slightly lower 
CD3 signal, so if you gate on the top portion of the CD3+, you will lose many CD8+).  
Set up a plot showing "all events" on your plot of interest (CD4 vs CD8), and gate on 
your population of interest (CD8+).  Then create a FSC/SSC plot (or whatever plot you 
wish to backgate onto) and "show populations>CD8+".  You will then be able to see 
where all of the events that are producing signal in the CD8 channel are localized, and 
possibly adjust your gates accordingly. 

 



  

 Cytometer Shutdown Procedure 

 
1.  Remove your last sample 
2.  Fill a tube 2/3 full with 0.1N NaOH.  Mark fluid level with 
sharpie. 
3.  Load tube on sample port, run with lever (“tube support 
arm”) to side for 1 minute--this will clear the tubing of the 
"Droplet containment module".  Verify that the fluid level 
drops 1 cm or more --if not, please notify me. 
4.  Move lever to center and “RUN” on “HIGH” for 2 
minutes.  Fluid level should drop another 1 cm. 
5.  Unload tube, and replace with a tube of Coulter Clenz 
(blue liquid) and repeat 2-4.  
6.  Unload tube, and repeat with a tube of water.  
7.  Leave water tube on sample port with less than 1 ml of 
water in tube.  Do not leave too much liquid in tube, as some 
backflow will occur, and if it fills completely then fluid will 
be forced into the sample pressurization holes, into the air 
line, and clog the hydrophobic filter.  
8.  Leave machine in “STANDBY”, or turn off if no one is 
using it after you. 

 
Before you leave, please check the sheath and waste tanks to make 
sure they are ready for the next user. If the waste tank is up to the 
“full” line, then swap in the empty one.  If the scale for the sheath 
tank is below the “fill” weight, please refill it.   Check the 
reservation calendar to see if anyone is signed up after you.  If not, 
please turn the instrument off. 
 

 



  

Optimizing setup of the LSR2 system 
(voltages and compensation) 
 

The goal of optimizing your voltage settings on a digital cytometer is to have 
good separation between your positive and negative populations while minimizing the 
overlap between your parameters.  A new method of instrument setup and tracking has 
been developed that will be recommended for all users of the flow facility.  For a more 
in-depth description of the processes involved, the following documents will be useful: 

 
-- BD Application note “Establishing Optimum Baseline PMT Gains to Maximize 
Resolution on BD Biosciences Digital Flow Cytometers” 
http://www.bdbiosciences.com/documents/Establishing_Optimum_Baseline_PM
T.pdf#search=%2823-8389-00%29 
--“Flow Cytometry Controls, Instrument Setup, and the Determination of 
Positivity”, Cytometry Part A, 69A, 1037-1042 (2006). 
 
The first step in this process is to determine the amount of electrical noise in the 

system.  The documents linked above will explain how this is done, but this part of the 
setup will be performed as part of facility QC and the results posted by the instruments.  
In short, the operator runs a dimly fluorescent bead and records data files where voltages 
are set in 50 volt increments (all parameters at 250V, all parameters at 300V, etc, up to 
800).  A plot of CV vs mean will allow you to derive the Standard Deviation (SD) of the 
electronic noise in the system.  The target mean value for your negative population 
should be 8-10 times this value to minimize the contribution of noise to your signal, and 
resolution of dim and negative particles will be optimum.  (Note that beads and cells, and 
even different types of cells, will have different amounts of fluorescence in each channel, 
but the *target mean signal* for each is still the same to optimize resolution). 

 
For most parameters with clearly defined populations, it is sufficient to set your 

voltages so that your unstained cells are in the first decade (mean of around 50, tail 
ending at around 200), but if you have a dim signal and wish to optimize the separation, 
set the voltage so the mean signal is 8-10 times the SD of the noise (typically resulting in 
a mean signal from 100-300 depending on the channel). As you increase above this 
setting, the negative population will also gain signal and your separation will not 
improve.  In addition, higher voltages will mean that you will get a higher response from 
overlapping signal, making compensation more difficult, so it is preferable to use the 
lowest voltage that gives the result you want. 

 
In the event that your positive population goes off scale at these settings, you have 

2 options.  Since you have separation of 3 logs or more, you may reduce the voltage to 
bring your bright population on scale.  Alternatively, you may titer down your antibody, 
which would allow you to save on reagents while still getting enough separation to 
identify your population of interest.  Another important consideration is that if your 
antibody is that bright in its own channel, it will also be bright in any channel it overlaps 
into, so titering the antibody will also aid in compensation, whereas lowering the voltage 

 

http://www.bdbiosciences.com/documents/Establishing_Optimum_Baseline_PMT.pdf#search=%2823-8389-00%29
http://www.bdbiosciences.com/documents/Establishing_Optimum_Baseline_PMT.pdf#search=%2823-8389-00%29


  

will make it harder to compensate.  With something like GFP, which cannot be titered, 
you will have to lower the voltage or use a neutral density filter in that detector 
(uniformly decreases signal reaching that detector) and deal with any compensation 
issues that this causes. 

 
 

Compensation 
Using these voltages you have determined, you can generate a compensation 

matrix and see if any problems arise.  When calculating compensation, it is critical to 
match the positive and negative particles—if you are using beads labeled with antibody, 
the positive population must be compared to unlabeled BEADS, while labeled cells must 
be compared to unlabeled cells, so that you are correcting only for the fluorescence 
contribution of the fluorochrome and not any difference in signal from cell to bead (or 
from cell to cell—Lymphocytes and monocytes have very different autofluorescence).  
Note that when SETTING the voltages, you want to optimize for the experimental 
particle you are measuring (usually cells), and then collect the compensation particles at 
these settings, regardless of what type they are. 

 
It is preferable to use antibody capture beads, especially if you have a label that is 

dim or low frequency (<1% of the population).  Beads will give you a bright, uniform 
signal for each reagent.  If you are using antibody capture beads for all of your colors, 
you can simply record unlabeled beads as the unstained control, and then single stained 
samples for each color, and the software will automatically use the unstained control as 
the negative for all tubes. 

 
For labels such as PI, CFSE, or viability dyes, which will only stain cells, you 

may just use cells for ALL of your controls (unless one or more of your labels is dim or 
low frequency—see below), and collect a sample of unlabeled cells as your unstained 
control.  Be sure to consistently gate on the same cell population (e.g. only lymphocytes), 
as different cells have different levels of autofluorescence. 

 
For viability dyes, you are typically gating out the positive events, so that the 

spillover of the viable cells is minimal since they have minimal signal—if you have been 
using labeled cells as the control and comparing them to unlabeled beads, the effect 
should be minimal but it is not the best way to do it. 

Invitrogen has a line of Live/Dead fixable stains that are amine-reactive dyes that 
will bind to any available amine groups. To compensate these dyes, they also produce 
Arc beads (A10346), which are amine-coated beads that will bind the dye and produce 
positive signal.  The live cells do have some signal so it is important to correctly 
compensate these dyes, as opposed to other viability dyes where they are excluded by the 
live cells and thus live cells are truly negative.  Live/Dead Red is PE-Texas Red,  

With CFSE, where you are interested in the POSITIVE events, it becomes more 
problematic—for instance, there should be minimal overlap of CFSE into the Pacific 
Blue channel, but if you are comparing CFSE labeled cells to unlabeled beads, you may 
in fact see the signal in the unstained beads is higher than the CFSE stained cells in Pac 

 



  

Blue because the autofluorescence of beads in Pac Blue is higher than the cells.  In this 
case it is much more important to compare to unlabeled cells to determine overlap. 

 
 If one or more of your antibodies is dim or very rare (<1% of the population) 
AND you have a reagent that must use cells (GFP, CFSE, PI, or an antibody that does not 
have a compatible capture bead), you may need to use a mix of beads and cells for 
compensation.  If this is the case, each compensation control tube will need an “internal” 
negative population for comparison.  Compensation requires comparison of labeled and 
unlabeled particles of the same autofluorescence, otherwise you will be correcting for the 
difference in autofluorescence in addition to the spectral overlap of the fluorochrome.  In 
many cases, the difference is minimal, but as an example the autofluorescence of most 
beads is a log higher than that of cells when using the violet laser, which will skew your 
values. 
 When preparing your beads, add a drop of the “negative” beads that don’t bind 
antibody.  For cells, either mix unstained cells into your single stained sample, unless the 
“unstained” will pick up the label (such as with PI), in which case you can bring a tube of 
unstained cells and just “append” them to your data file of stained particles.  You will 
then need to go through and draw a new interval gate on the negative population in each 
of your single color histograms, and calculate compensation as usual.  The software now 
uses the negative population defined in each tube for the comparison rather than the 
unstained sample.  Alternatively, you could collect unstained cells as the unstained 
control, and do not draw a negative interval marker for colors using cells as the control.  
The software will use the negative populations you defined for the bead samples for those 
colors, and the unstained sample as the reference for the cell samples that do not have 
negative populations defined.  

Remember that your particles will be giving off the same amount of light (unless 
you change the laser power, which is fixed), and adjusting the voltage changes the 
sensitivity of the *detector*.  Compensation is determining what percentage of the 
“primary” signal is being detected in the other channels—if you have 30% overlap of 
FITC into PE and you increase the voltage in the FITC detector, you will increase the 
primary signal while the overlap signal stays the same—thus, the % of overlap will 
decrease.  If you decrease the FITC voltage, the measured FITC signal will be lower 
while the overlap into PE will be the same, so you will have a higher % of overlap.  
Likewise, decreasing the PE voltage will decrease the amount of overlap signal detected, 
also resulting in lower % of overlap.  However, if you decrease the PE voltage in this 
case, then your measured PE signal for your PE control will be lower, and your % 
overlap into PE-Cy5 (for example) will be greater.  

 
If any parameters require >100% compensation (which means that the 

“overlapping” signal is brighter than the “measured” signal), it may be necessary to 
further adjust your settings.  One quick trick you can use is to run (without recording) 
each of your single stained samples with the “unstained control” tube active—you will be 
able to see how much signal is generated by your particles in all of the channels, and just 
make sure that the brightest signal is in the histogram for the color that control is labeled 
with--your APC single stain control should have the brightest signal in the APC 

 



  

histogram, but you will see some signal in APC-Cy5.5—just make sure it is not brighter 
than signal in APC. 

 
In this case, if APC-CY5.5 is brighter, you can either increase the voltage to the 

APC channel, or decrease the voltage in the APC-CY5.5 channel (or both), so that the 
APC signal is brighter.  Remember that this will impact the other colors as well, so if you 
choose to decrease the voltage to APC-Cy5.5, then the APC-Cy5.5 sample will have 
lower “primary” signal, and the spillover into APC-Cy7 could be brighter—a balance 
must be struck to get everything to agree.  Adjustments of more than 50 V in either 
direction from your initial settings should be made with great caution—please see me if 
you have any problems. 

 
 Once you have determined the “optimal settings” for your samples (good 
separation and minimal overlap), it is then possible to run a mid-range bead (see below) 
at these voltage settings and determine the mean signal levels for these beads in each of 
the channels.  By running these same beads and matching these values on subsequent 
days or on a different instrument (by adjusting the voltages for each parameter to match 
the signal levels), you will ensure that the instrument is detecting the same signal levels 
from day to day (but compensation should still be calculated with each experiment, as 
tandem dyes may vary).  The Application Note referenced above recommends a “mid-
range bead” (BDBiosciences cat # 556298) but the signal on the UV-B (440/40) channel 
at typical voltages is off scale, so a different particle needs to be used for these channels.  
Spherotech Midrange Rainbow Fluorescent particles, RFP-30-5A, seem to work well in 
all channels.  This procedure is detailed more fully in “Tracking Settings with Rainbow 
Beads” available on the website. 
 
 
 

 



  

LSR2 Optimization Summary  
 

I. Determine control samples required 
a. You will need one tube of unstained cells (for the initial run at least). 
b. You will need one single-stained control per color in the experiment. 
c. Antibody capture beads should be used for your single stained controls 

unless any of the following apply: 
i. If you are using PI, CFSE, or Invitrogen amine-reactive viability 

dyes*, these reagents will ONLY stain cells, so cells must be used 
as control for this color.   Note:  *Bangs Labs make an amine-
tagged bead that may be used with the amine reactive viability 
dyes instead of cells—but unlabeled bead from Bangs Labs may be 
different from BD comp beads! 

ii. If you are using an antibody that is NOT from mouse, rat, or 
hamster, BD’s antibody capture beads will not bind them and you 
will need to use cells as your controls for at least those colors. 

d. For single fluorochrome labels (FITC, PE, APC, Pacific Blue, etc), if the 
signal for your antibody is dim (no defined population can be resolved) or 
frequency is low (<1% of population) and you wish to use cells, you may 
substitute another antibody of the same color with a more robust response 
(CD8, CD4, etc) for the purposes of compensation.  If using beads, they 
will give a bright uniform signal so it doesn’t matter how the antibody 
stains cells. 

e. If you are using a tandem dye (PE-Cy5, APC-Cy7, etc), you MUST use 
the same exact reagent as in the experiment—if it is dim or low %, capture 
beads should be used. 

f. If you are using mixed controls (some cells, some beads), each sample 
tube must have a negative population in it.  Compensation must be done 
comparing the same particle so that differences in autofluorescence are not 
skewing the calculation.  If you have mixed particles, you cannot collect a 
“universal negative” for all of them to be compared to. This means for 
beads, you must include a drop of the “negative” beads (that do not bind 
antibody) in your tube.  For cells, if 100% of the cells get labeled and if 
the staining won’t bleed over, then you can add some unstained cells to the 
stained cells (as long as the stained cells have been washed, etc).  
Otherwise (like with PI) you can use the tube of unstained cells (will 
explain below). 

 
 
 
 
 
 
 
 
 

 



  

 
 

II. Initial setup 
a. You will need unstained cells, unstained beads (only if all comp tubes are 

labeled beads), single stained compensation tubes, FMOs if needed, and 
midrange rainbow beads (Speherotech RFP-30-5A). 

b. Create new experiment.  Select “instrument settings” and select desired 
colors in the “inspector” window (magnifying glass icon). 

c. Go to Experiment pulldown menu>instrument setup>create compensation 
controls. 

i. Activate “unstained control” tube and load unstained cells. 
ii. Adjust voltages for FSC/SSC to get events on scale, and for 

fluorescent channels so that: 
1. for clearly defined populations, the edge of your negative 

population should be around 200 (tick after 102, mean~50) 
2. If low signal is expected/experienced in that channel, then 

mean of negatives should be between 100 and 300. 
iii. If using only cells, record unstained cells as unstained control. 
iv. If using only beads, record unstained beads as unstained control. 
v. If using mixed beads and cells, go to Instrument pulldown menu, 

“modify compensation controls”, and turn off “Unstained control 
tube” checkbox at the top.  Click OK.  This will remove the 
“unstained control” tube from the Comp Control Specimen. 

vi. Continue on recording each of your single stained controls.  If 
comp controls are mixed particles, each tube should have a 
negative population in it.  If necessary, to create a “negative” 
population in a cell sample, you can collect the stained sample and 
then load the unstained cells and “append” to the file (click Record 
again, and choose “append”). 

vii. Go through each of your worksheets and make sure the positive 
population is properly gated.  If you do not have an unstained 
control tube, you must also draw new interval gates on the negative 
population in each histogram. 

viii. Instrument pulldown menu>Intrument setup>calculate 
compensation. 

d. With experiment name highlighted, click on syringe button to create a new 
specimen. 

e. Expand specimen to view tubes. 
f. Activate first tube, rename as “rainbow beads” 

i. Load and run midrange rainbow beads, record. 
ii. Expand rainbow beads tube, and select “instrument settings” that is 

revealed.  These will show the settings used for collecting that tube 
in the inspector.  Click on the “compensation” tab, and click on the 
checkbox to disable compensation. 

 



  

iii. Select the green “worksheet” button in the browser to create a new 
global worksheet.  If it is greyed out, click on an element in your 
experiment and it should become activated. 

iv. Draw FSC/SSC plot on worksheet, and histogram for each color.  
Draw a region around your single bead population.  This should be 
P1. 

v. Right-click on border of any plot, and select “create statistics 
view”. Right click on statistics view and select “edit statistics 
view” 

vi. In the “header” tab, turn off all checkmarks.  In the Populations 
tab, turn off all checkmarks except for the one under “Show 
Population” that is next to your FSC/SSC population (P1).  In 
“Statistics” tab, make sure only “mean” for all fluorescence 
parameters are checked.  Click OK. 

vii. The values displayed indicate the fluorescence levels of the beads 
for each of the channels you measured.  Make note of these values. 

g. Return to the main global sheet, draw your plots for gating, and record 
your sample tubes.  To add tubes to your specimen, you may either click 
the tube button at the top of the browser, or click “next” in the acquisition 
controls. 

 
III. Future experiments 

a. If duplicating your experiment layout, go to the Global Sheet 2 with the 
rainbow bead plots.  Otherwise, re-create it. 

b. Load a tube of your Mid Range Rainbow beads (same lot number as 
before). 

c. Adjust the voltages so that the mean signals detected for each parameter 
match the values detected during the initial setup (within reasonable 
limits, i.e. +/- 5% or so).   This should be done with compensation turned 
OFF, and will result in your detectors having the same response to the 
same fluorescence as in your initial setup experiment. 

Run compensation tubes as usual, calculate compensation, and run sample tubes. 
 

 



  

Tracking settings with Rainbow Beads 
 

Purpose:  to ensure consistent signals over the course of a project, and verify 
proper function of the cytometers. 
 
 Rationale:  The components of a cytometer can display variability from day to 
day.  Fluctuations in laser power, changes in temperature and humidity affecting the 
PMT’s, and changes in alignment on the instrument are just some examples of variables 
that can impact the output.  In order to minimize these variations, a consistent 
fluorescence standard should be run with each experiment to make sure that the signal 
output of the instrument for a given level of fluorescence is kept consistent.  To do this, 
we use a stable source of fluorescence (rainbow bead with a matched lot #), and then 
adjust the user controlled settings (voltages) to match the output. 

Unless there have been some major adjustments made to the instrument, settings 
should not vary by more than 20V or so.  An added benefit of monitoring the instrument 
settings with beads is that it is readily apparent when something has happened to the 
instrument, such as a laser dying etc. 
 

Procedure:  After establishing settings for a given panel of reagents (explained 
elsewhere) such that all signals are on scale, compensation between channels is 
minimized, and separation of populations is either optimal (for dim labels) or sufficient 
(for bright ones), the operator collects a data file of a rainbow bead or other particle that 
gives positive signal for the established settings.  For the next experiment, the first step 
would be to run the rainbow beads, and match the UNCOMPENSATED MFI from the 
initial run, to make sure the output of the instrument for the same level of fluorescence is 
the same. 
 
Step by step 
On the initial day of your experiment: 

1. Establish your panel settings (discussed elsewhere) and run your experiment 
(calculate compensation, collect your data files). 

2. “Duplicate without Data” to create a copy of your experiment you just ran.  Right 
click on the “Cytometer settings” directly beneath the experiment name, and 
“Unlink from setup” if that is an option. (Only happens if you link your 
compensation matrix instead of “apply only”).  With “Cytometer settings” still 
selected, view the Compensation tab in the inspector.  Select the first line, scroll 
to the bottom of the list, hold shift and select the last line, so that all compensation 
pairings are selected, and click “clear”.  This will set all of your values to 0. 

3. Create a new global worksheet (button shown below), and label it “setup” 

 
 

 



  

4. Draw a FSC/SSC dot plot, and a histogram for each color.  See image at the end 
of this document. 

5. Create a new tube, call it “baseline” and collect a data file of mid-range rainbow 
beads (Spherotech, RFP-30-5A) or another appropriate control particle.  It may be 
necessary to change the FSC or SSC settings to be able to visualize the beads, and 
this is fine, and will not affect your compensation results. 

 
 
6.  On the “setup” worksheet, draw interval gates on the peak in each histogram.  To 

accurately locate the peak, you can use the “+” magnifying glass tool and draw a 
box around the area to zoom in on (as shown in FITC below). 

7. Rename experiment “4 color template” or whatever name will identify this 
experiment type. 

8.  “File>Export>Experiment”, and save the experiment to your D drive folder.  This 
will create a template of your experiment with the baseline rainbow beads saved 
with it. 

 
On subsequent experiments using the same layout: 

1. “File>Import>Experiment” and import your template. 
2. Change the name of the experiment to suit your method, and relabel any tubes as 

necessary. 
3. Switch to the global sheet, and view the “setup” sheet.  Activate the “Baseline” 

data file (specimen “Rainbows”) and verify the interval markers closely bracket 
the peak of signal. 

4. “Next Tube”, label with the date, and run a tube of the SAME LOT of Rainbow 
beads.  Check the instrument settings to make sure compensation is disabled 
(“Enable compensation” is de-selected or all values are 0). 

5. Adjust voltages to center the peak in the interval marker (trying to match the MFI 
values in a stats view can be tricky as they refresh while the tube is running and 
can vary quite a bit). 

6. Record a data file of the rainbows.  Now you can go back and run your 
compensation tubes as usual, and no further voltage adjustments should be 

 



  

necessary (other than FSC/SSC for your cells).  Double check that compensation 
is “enabled” after calculating compensation. 

 
 

 
 
 

 



  

DIVA Software tricks and tips and traps  
 
-In the “Time” scale, 1 second= 100, so “6” on the bottom scale (x1000) is 1 minute. 
-Do not use “/” in experiment name, when exported it becomes ,2f, (so that 1/15/05 
would be saved as “1,2f,15,2f,05”). Use _ or -. 
-Double click on worksheet buttons to make them “sticky”—action will be performed 
each time you click the mouse button. Escape or click another button to turn off. 
-Stopping acquisition before reaching your target number of events can slow down 
response time. 
-Please report any software crashes or any other issues to me by email or in person. 
-You can open Task Manager by pressing control/alt/delete and then choosing “task 
manager”.  Under the “processes” tab, find diva.exe, and the number on the right 
indicates how much memory you are using.  As this number increases, response time will 
also increase.  Over 1,000,000 and the program is likely to crash/freeze.  The more events 
you collect, and the more tubes in the experiment, and the more dot plots and statistics 
views you create, the more memory that is used and the higher this number is.  To reset it 
you have to quit the software and reopen.  Sometimes minimizing the FACSDiva window 
will also clear the memory.  If it jumps back up to 1,000,000 again, you will have to 
either logout or quit and reopen. 
--Do not export directly to external storage devices.  It will take much longer, and some 
files may be omitted or truncated.  You should export to the “D” drive and then copy. 
--If you export as an experiment and then open those files in Flowjo, H and W parameters 
will be switched, so that selecting FSC-H in Flowjo will display FSC-W. 
 
Edit>user preferences, in the General Tab, you should de-select “Save Analysis after 
recording through Global worksheet” and note the option for “Load Data After 
Recording” – if you collect many events, you can turn off this option to avoid the delay 
between tubes while the software processes the data for display.   

 



  

Data Management 
 
- A 9-color, 500,000 event data file will be roughly 30 MB, 1 million events 
60 MB, so 16 tubes (data files) of 1 million events will be 1 GB! 
- The Diva "database" within the software (everyone's experiments that 
appear in the "browser" window while the program is running) can only 
handle 15 GB total data.  Users are limited to 2 experiments each within 
Diva, and nothing older than 2 weeks. 
-User folder/file storage—each user has a folder on the D drive for storing 
experiments and files.  Please minimize data storage on core instruments.  
No more than 3 GB in any personal folder.  To check folder size, right click 
the folder and select "Properties". 
-  Please keep all files and folders in your user folder- any unidentifiable 
folders or files not in user folders will be removed. 
- Every Monday excess data is exported from the Diva software so that no 
one has more than 2 experiments in their profile and nothing is older than 2 
weeks.  Please maintain your own folders and do not rely on us to do it for 
you!  If excess data is found in your diva profile, it will be exported as an 
experiment to your folder on the D drive, in a new folder labeled 
"experiments MMDDYY".  If you need the experiment in Diva for 
duplicating or to export as FCS, it can be imported back in and it will appear 
exactly as it was when we exported it. If you do import something back in, 
please delete it again when you are done!  If you make changes to an 
experiment you have imported in and wish to save them, you must re-export 
the experiment.  If you need the files in the “experiments MMDDYY” 
folder, please move them out of that folder.  Please delete any experiments 
you already have backed up elsewhere, and delete the “experiments 
MMDDYY” folder once you have made sure you don’t need any of the 
contents. 

 



  

Exporting  
 
There are 3 ways to export your experiments: “experiment”, “fcs”, or 
“template”—Different information is saved depending on your choice.   

Exporting as an experiment creates a folder with the same name as the 
experiment, and an XML file with the same name that has all of your 
experiment information (parameters, settings, compensation matrix, dot 
plots, tubes and specimens, etc), and saves each tube as an fcs file which is 
given just a number as a file name.  This format is mainly for use with Diva.   

It is possible to use these FCS files in Flowjo, but you will have to 
edit the columns to show the “tube name” to identify the different tubes, and 
if you record H and W parameters (for doublets, cell cycle, etc) these 2 
labels are switched (so selecting FSC-H in Flowjo will show you FSC-W 
measurements). 

Once exported in this format you can delete the experiment in the 
Diva software, and then import it back in at a later date and it will appear 
exactly as it was when you exported it.  The folder name must match the 
name on the XML file, so if you change the name of the folder, you will not 
be able to import it as Diva will not recognize it.   

Exporting as FCS files will also generate a folder with the same name 
as the experiment, and then one file per tube in the experiment, labeled as 
Specimen_tube.  Files in this format can be loaded into Flowjo or other third 
party software for analysis.  However, they do NOT save the analysis 
objects from the experiment in Diva, and if you wish to import them back 
into Diva, you will have to generate an experiment layout to import them 
into. 

One strategy of data management is to export the data tubes as fcs 
files, and then duplicate your experiment without data, and export the empty 
experiment as an experiment.  When you wish to view your data files in 
Diva again, import the empty experiment file, and then import the fcs files 
into that empty experiment. 

Exporting an Experiment template:  one of the export options for an 
experiment is to export it as a template, and it will be saved in the list of 
Diva templates that can be accessed by using the pulldown menu to create a 
new experiment. DO NOT USE THIS OPTION. 
--Do NOT export directly to an external drive, as it will take twice as long, 
and sometimes truncates very large files or does not export all files.  It is 
faster to export to your folder on the d drive and then copy/transfer to your 
external drive or burn a cd.

 



  

Experiment Templates 
 If you are using the same panel on multiple days, there are a few 
strategies to avoid having to re-create an experiment layout each time.  Some 
are described below. 
 If you opted to "Link and Save" your compensation settings on your 
experiment (a yellow chain will appear near your instrument settings), they 
will carry over to the new experiment, and even if you calculate a NEW 
matrix, it will be locked into the old one.  Unlinking is essential to make sure 
your compensation is correctly applied.  Right click on the instrument 
settings icon (right under the experiment name) and select “unlink from 
####”.  This can be avoided by choosing “apply only” when compensation is 
calculated. 
 If you have an experiment in your browser that you wish to reuse, you 
can simply right click the experiment and select "Duplicate without data" 
(experiment must be open).  This will make a copy of the framework of the 
experiment but will not include any data files, so you can just record new 
files for each sample tube.  Again, make sure experiment is not "linked" to a 
compensation matrix.  The best way to reuse experiment layouts is outlined 
in the “Track Settings with Rainbow Beads” document. 
 The preferred method would be to "duplicate without data", and then 
rename the experiment to "MW 6 color template" or something you'll 
recognize.  If the original experiment used the "Link and save" option for 
compensation, right click the instrument settings and select "unlink".  Click 
on the “instrument settings” and view “compensation” in the Inspector, 
select all lines, and “clear” to set all values to 0.  Then choose 
File>Export>Experiment to export your EMPTY experiment as an 
experiment file and store it in your D drive folder--the folder created which 
matches the experiment name will only have the xml file in it.  For future 
experiments with this layout, simply Import the template experiment and it 
will be ready to go, and you won't need to keep a FULL experiment in your 
browser for duplicating. 
 

 



  

Transferring Files 
 
There are several options for transferring files from instrument workstations.   
 
Flashdrives and external storage may be used, but please ensure they are 
virus free, and do NOT export directly to the drive—export to the D drive 
first, and then copy them to your external storage.  Diva will take longer to 
export to a usb drive, and will sometimes truncate or leave out some of the 
data files.  Partners is now requiring all portable storage devices to be 
encrypted.  CDs or DVDs may be burned as well.  Other options using the 
network are described below: 
 
File transfer: 
Using Internet Explorer, go to portal.partners.org and type partners\abc12 
(your ID code) and your partners password. 
The drives mapped to your profile will appear in either “Network Places” or 
in “My computer”.  You can drag and drop, but be aware of storage limits on 
the server. 
 
Email: 
Research computing offers a large file transfer service that zips the folder or 
files for you and emails a link to download them.  Go to 
https://transfer.research.partners.org, you will need to create an account and 
it is pretty self-explanatory. 
 
MAD Server: 
We have an account on a MAD storage server which is web-based, you 
upload your files over the web to the server and then download them to a 
different computer on the web.  Contact Mike for details. 
 
There are other means to connect over the network that require passwords 
etc.  See Mike if you want to try other transfer methods.

 

https://transfer.research.partners.org/


  

BD High Throughput Sampler User’s Guide 

For the 

3 Laser BD LSRII and 5 Laser BD LSR Fortessa 

I. Introduction 

The BD High Throughput Sampler (HTS) is a high-speed sample loading device used on 

the 3 Laser BD LSRII and the 5 Laser LSRFortessa located in Rm. 5227 of the Ragon 

Institute Flow Cytometry Core Facility.  The HTS provides users the ability to acquire 

samples from 96-well or 384-well plates for efficient analysis with minimal carryover.  

This guide will serve as a step-by-step process of installation, acquisition, shutdown and 

removal of the HTS system.  (Note: All users must be trained on installation/removal 

prior to their first use of the HTS.)  

 

 



  

II. Installation of HTS for Plate-Based Acquisition. (Note: The devices are HEAVY 

and may require some assistance from Core Personnel) 

 

There are two HTS devices located in Rm. 5227 on the shelves across from the 3 Laser 

BD LSR II and the 5 Laser BD LSRFortessa, each labeled accordingly.  

 

1. Make sure sheath tank is full and waste is empty. 

2. Prior to moving HTS devices: Switch acquisition control switch to Plate mode 

located to the right of the sample station with instrument in “standby”.   

(When Plate mode is on the aspirator pump is off, if instrument is in “run” the SIP 

will drip) 

3. Move aspirator arm to the side and remove Droplet Containment Sleeve (DCM).  

Unscrew (clockwise) the tube retainer until you can remove the DCM sleeve 

freely. Store DCM sleeve in styrofoam rack. 

4. Replace DCM with SIT protector which is kept in the drip tray on HTS unit (See 

Figures Below)  

 

5. Move tubing and wires connected to LSR under the sample port for easy access. 

6. Remove HTS safety cover and install HTS Unit onto the cytometer. 

3 Laser LSRII: HTS Unit has base plate attached and can be installed on to 

cytometer by inserting the metal rod in to the brace underneath the sample station.  

Leave the HTS Unit resting on the notch in the metal rod securing the HTS Unit 

away from LSR to allow easy access when connecting cables and tubing. 

5 Laser LSRFortessa: HTS Unit base plate is permanently installed on the LSR.  

HTS Unit is placed on the sliding base plate to the right of the sample station.  It 

 



  

will be easier to attach power and communication cables with HTS unit facing the 

user. 

7. NOTE: DO NOT GET THE POWER CORD WET. IT WILL SHORT CIRCUIT 

THE ENTIRE INSTRUMENT. Connect the power and communication cables to 

ports on the rear right side of the unit. (See Figure Below) 

 

8. 5 Laser LSRFortessa: Once power and communication cords are connected, slide 

the HTS Unit in to place with absorbent pad underneath the SIP  

9. 3 Laser LSRII: Disconnect sheath tubing from HTS unit and connect to LSR, as 

seen above.   

5 Laser LSRFortessa: Sheath tubing is permanently connected to the LSR.  

10. Locate tool box and find the “purging assembly line” rubber tubing with one 

open-end and one female connector attached.  Setup a beaker to catch sheath bled 

from instrument. Connect the female socket to the sheath tubing connected to the 

LSR and allow sheath to bleed for a few seconds. (See figure below) 

  
11. Disconnect “purging assembly line” and place a few drops of sheath fluid from 

sheath dropper in the empty sheath connector on HTS prior to reconnecting lines. 

12. Connect the sheath and waste line from the LSR to the HTS unit. 

 



  

13. CAREFULLY, attach the sample coupler to the SIP (Sample Injection Probe).  

Push sample coupler onto the SIP until you feel a stop. Hold the sample coupler in 

place and tighten the top nut. (See Figure Below) 

 

14. 3 Laser LSR II: Slide HTS unit all the way back toward the cytometer. 

15. Place safety cover back on HTS Unit and turn on the HTS power switch. 

16. Set Instrument to “Run” and open BD FACSDiva software. 

17. In BD FACSDiva software, select HTS > Prime, 2-3x to remove air bubbles 

caught in tubing. (Note: Safety cover must be on for software to execute Prime 

function.  Inspect blue/green tubing connected to the syringes/pumps on the front 

and back of the HTS unit where air is usually seen.  Tap tubing in between primes 

to loosen any air bubbles caught in tubes.  It will be necessary to remove the 

safety cover to access the tubing on the front syringe/pump, tap tubing then 

replace cover before priming.  Many Primes may be necessary in order to 

completely remove all air)  

18. NOTE: If Diva is already running, install HTS device and select “ReInitialize” 

from HTS drop-down menu.  Communication between HTS unit and software 

will now be connected. 

 

III. HTS Acquisition 

Setting up Plate: (Note: If running multiple plates under the same setup and 

compensation conditions, one set of wells for each is necessary on the first plate only and 

subsequent plates may contain specimen only wells.) 

 

 



  

1. Row A will be used for Setup Controls (Note: Ideally, two wells will be used. 

One will contain unstained experimental cells for determining FSC vs. SSC 

voltages and the other will contain mid-range rainbow beads used for determining 

voltages for parameters)  

2. Row B will be used for single-stained Compensation Controls 

3. Remaining rows will be used for Experimental Specimens. 

 

Setting up Experimental Plate Editor and Worksheet: (Note: If multiple plates are to be 

run with the first containing setup and compensation wells and any subsequent plates are 

specimen only wells, multiple plate layouts must be created to accommodate designs.) 

 

1. Create a new experiment in the browser window and select the parameters used in 

the experiment. 

2. In the browser toolbar select the type of plate used in the pull down menu next to 

the plate icon.  Plate layout should appear.  If not, double-click created plate icon 

in browser window to view layout editor. (See Figure Below) 

 

3. In the plate layout window, select the first two wells (A1/A2) and click the setup 

well icon in the plate toolbar.    This will be used to determine FSC vs. SSC 

voltages for cells as well as parameter voltages and applies default settings for 

acquisition accordingly.  These wells are collected in Standard Mode allowing 

time to adjust voltages. The remaining wells for compensation and specimens can 

be run at either Standard or High Throughput speeds. 

 



  

4. In the plate layout window, select the first well in row B (B1) and right-click the 

highlighted well.  In the menu, select Setup > Create Compensation Controls… 

This will assign each well in row B to a single control and applies default settings 

for acquisition accordingly.  (Note: Make sure plate layout matches the order 

listed in “Create Compensation Controls”.  If necessary, reorder 

fluorophores/parameters by dragging bullet points up/down in list) 

5. In the plate layout window, select the remaining wells that have experimental 

samples by either holding the Shift key to select continuous wells or the Control 

key to select individual wells.  Select the Specimen icon to apply specimen wells. 

  This will assign each selected well with a specimen and applies default 

settings for acquisition accordingly. 

6. Select the Throughput Speed for Specimen tubes.  Default settings are applied 

with respect to Standard/High Throughput speeds.  (Note: These settings can be 

modified depending on sample volume and concentration.)  (See Figure Below) 

 

7. Note: Plate acquisition can only be recorded using a Global Worksheet.  View the 

Unstained Normal Worksheet, and choose Edit > Select All > Copy.  Then view 

the global worksheet, right-click and choose Paste. 

8. Layout setup is complete and samples are ready to be acquired. (Note: If running 

multiple plates under the same setup and compensation conditions, create one 

layout for each plate that includes the proper setup/compensation/specimen wells) 

 

Running Plate: 

1. Remove safety cover from the HTS unit and place the plate with well A1 at the 

back-right corner of the stage, closest to the sample probe.  (See Figure Below)  

 



  

 

2. Replace HTS safety cover. 

3. In the Acquisition Dashboard select Show Plate Controls. 

4. Select the two Setup Control wells in the plate layout of the Setup view.  They 

will appear outlined in green. 

5. Select Run Wells on the Dashboard.  The setup wells will be injected in to the 

cytometer and adjustment of voltages can take place at this time. 

6. Once voltages have been set, Compensation tubes can be acquired.  Select all 

compensation tubes and click Run Wells on the Dashboard. 

7. Once Compensation tubes have been recorded go to the normal worksheet and 

individually click through each of the tabs labeled with single controls.  (Note: 

Since, the HTS system only runs using the Global Worksheet, the software does 

not apply gates to the individual compensation wells until each tab has been 

viewed by the user and positive gates have been determined.) 

8. Experiment > Compensation Setup > Calculate Compensation 

9. View the Global worksheet 

10. IMPORTANT: Setting Events to Record: Either click each well separately and 

select desired events, or go to Experiment > Experiment Layout.  Under the 

Acquisition tab, select wells and assign number of events to record.  (Note: In the 

plate editor window only the green highlighted well is changed when selecting 

events to record even if multiple wells are selected.  If sample is loaded and not 

collected, it is LOST) 

11. Select specimen well and click Run Wells on the Acquisition Dashboard 

 



  

12. Once plate has finished running, a second plate can be loaded on to HTS with the 

correct plate layout selected or move on to the cleaning/shutdown procedure. 

 

IV. Cleaning/Shutdown Procedures 

1. A separate plate must be created with 8 wells: (See Figure Below) 

a. A1-A4 = 4 wells Coulter Clenz 

b. B1-B4 = 4 wells DI Water  

 

2. Remove Cover on HTS and place Cleaning Plate in same orientation as previous 

experimental plates. 

3. HTS > Clean, select Daily Clean 

4. Replace cover and click OK 

5. Once finished daily cleaning procedure, move on to Removing HTS 

 

V. Removing HTS Unit and Set Up for Tube-Based Acquisitions (Note: The devices 

are HEAVY and may require some assistance from Core Personnel.  Reference images 

found under “Installation of HTS for Plate-Based Acquisition”) 

 

1. 3 Laser LSR: Hold both sides of the HTS unit and slide it away from the 

cytometer until it stops in the base plate. 

 



  

2. Disconnect sheath line from the HTS and connect the purging assembly line 

(female connector and open end) from step 10 of installation.  Place the open end 

of tube in a beaker of H2O. (See figure below) 

 

3. HTS > Prime 3x 

4. Place cytometer in “Standby” 

5. Disconnect H2O priming tubing from HTS. 

3 Laser LSRII: Reconnect sheath tubing to HTS and disconnect other end from 

LSR 

5 Laser LSRFortessa: Disconnect sheath tubing from HTS Unit  

6. Disconnect the waste line from the cytometer 

7. Detach the sample coupler from the SIP 

8. Disconnect the power and communication cables from the unit.  Cover power 

cord adapter with a clean, dry tube. 

9. Carefully lift and remove the unit. 

10. Remove SIT and place in absorbent tray on HTS Unit 

11. Replace the DCM sleeve 

12. Tuck all cords attached to the cytometer off to the side out of the way of the 

sample chamber 

13. Switch acquisition control switch to tube mode. 

 

 

 

 

 



  

IMPORTANT!  

VI. Additional Procedural Notes and limitations: 

1. Cytometer must be placed in “Run” and cover installed on HTS prior to opening 

BD FACSDiva software in order for it to be recognized by the computer. 

2. If Diva is already running, install HTS device and select “ReInitialize” from HTS 

drop-down menu.  Communication between HTS unit and software will now be 

connected. 

3. Cytometer can be placed in “Standby” when not running plates, primes, cleans, 

etc. 

4. Cell concentration should not exceed 6 x 106 cells/ml in 250µl volume. 

5. Software will stop acquisition (recording of a well) and proceed to the next well 

when either the specified number of events collected is reached or the stopping 

time is reached.  Stop time (sec) = sample volume (µl) divided by flow rate 

(µl/sec). Set number of events high if you want to record up to the stop time. 

6. Plate should be mixed prior to HTS setup.  Avoid creating any air bubbles in well. 

7. Use only plates made by either BD Falcon or Costar. Only these plates are 

validated for the HTS. 

8. Do not exceed a 1M cell count per well in the acquisition field of the Diva 

program (location in the acquisition layout). This will result in a plate memory 

error. 

 



  

Troubleshooting 
 
--Missing experiments in your profile:  Read section on "Data Management" 
 
--Tube Fills while cleaning or running samples: 
 -check to see if tube is cracked 
 -if during cleaning, fills while arm is to side, DCM is clogged- notify 
core personnel.. 
 
--clogged sample probe/ no sample flow:   
 
--High pitched alarm--waste has an alarm built in.  check tank to see if it is 
full. 
 
 
No events;  press prime while acquiring, this should trigger hundreds of 
events per second for a brief time—if you see no events, restart the 
computer.  If you do see events, then the computer and instrument are 
communicating and the sample probe may be clogged.  With the instrument 
on run, center the arm without a tube loaded.  If it drips, that is normal.  If it 
does not drip, the sample probe is clogged.  You will have to notify core 
personnel. 
 

 



  

Baseline Correction and potential issues 
 
 
 In order to 
remove background 
signals due to unbound 
fluorophores, dark 
current, and ambient 
light, the Diva Software 
averages signals 
between events and 
subtracts this from the 
total signal. 
 
If there is no signal for 
that parameter, this can 
result in a negative 
value for that event. 
 
 
 
 

 
 
 Most of the time, signals are 
corrected appropriately and this 
results in a population mean that is 
consistent regardless of flow rate. 
(You may possibly see a higher 
CV/more spread at higher flow rate 
due to greater measurement error). 
 Population labels to the left 
refer to the flow rate used for 
acquisition of the events in that gate. 
 

 
 
 
 
 
 

 



  

 

Where it can go wrong 
 
 Usually threshold is set on 
FSC– in cases where particles are 
very different in size, one may be 
below threshold while the other is 
on scale (such as cells and beads or 
debris). 
 Because it is below threshold 
and is not an “event”, the signal of 
the small particle is averaged into 
the baseline and subtracted from the 
signals. 
 In this example, negative cells and 
fluorescent beads are in the same sample.  
The beads are so small they fall below 
FSC threshold and are ignored.  Their 
bright fluorescent signal is averaged into 
the “baseline” which is subtracted from 
the signal measurement 

This can lead to your negative 
populations shifting artificially far into 
negative values and can lead to problems 
with your data files. 
 
Confirming issue: 

• One way this issue can be illustrated is to run at different flow rates.  
The higher the flow rate, the more “undetected” particles that will be 
present, and the higher the baseline 
error 

                
 
 
 
 
 
 
 
 
 

 



  

Solution: 
 
Apply a second threshold: 
Applying a second 
threshold that identifies 
the small particle makes 
sure all events are detected 
and the baseline is not 
erroneously high—events 
above T1 OR T2 will be 
recognized and recorded.  
Alternatively, you can 
decrease your FSC 
threshold to include the 
debris, but you may not be able to set it low enough to detect all of them. 
 
 

 
 
From the BD whitepages: 
2.5 Baseline Restoration 
PMT signals can contain a high level of background from a variety of sources: light from 
unbound fluorophores, PMT dark current, and ambient light. Background signal is 
eliminated in two stages. The first, gross adjustment is made during the initial conversion 
of the signal from current to pulse. (Photomultiplier tubes are a source of current.) After 
pulse conversion in the preamp, the output signal falls in the range of 0 to 5 V. This 
initial gross adjustment preserves the dynamic range of the A/D converters for signals of 
interest, and maintains a safety margin of 100 mV. 
The second, final adjustment is made just before area and height are measured. The 
FPGAs (Figure 2) calculate a running average of the data outside any window gate to 
remove the last 100 mV (Figure 3). 
 
 

 



  

Related posts from the Purdue list: 
From the Purdue message board, Marty Bigos (Gladstone Institute of Virology and 
Immunology) answered a question from someone who asked about a drop in signals 
when running on high with large amounts of debris blocked by threshold: 
 I will post a hypothesis on why the SSC decreases with increased flow rate 
when there are a significant number of particles below threshold (FSC).  The DiVa 
systems (Aria, Canto, VantageDiVa) have a baseline subtraction calculation whereby 
each measurement channel is sampled between threshold events and an average value 
calculated which is then subtracted from the measurements on that channel (when 
measuring Area). So if you had s lot of RBCs in your sample below threshold, the faster 
you ran your sample, the higher your average background baseline on SSC will be. To 
see if this is the case, you could look at SSC-H. This does not have an integrated baseline 
subtracted, so it should remain constant regardless of flow rate. 
----------------------------------------- 
----------------------------------------- 
On Jun 18, 2009 
Dear flow cytometry experts, 
Several of our researchers are having the same problem. Voltages are set based on an 
unstained sample. Then a CD150 sample is run. The negative population appears MORE 
NEGATIVE than anything in the unstained sample. 
We have seen this on FACSAriaI, AriaII, and LSRII. We have seen this with CD150-PE 
as well as CD150-PECy7. We are hopelessly confused. How is this even possible? Has 
anyone out there seen anything like this? I'm attaching a picture (tif file) of what I'm 
talking about. 
Thank you, 
Kat Folz-Donahue 
Flow Cytometry Core 
Harvard Stem Cell Institute | Center for Regenerative Medicine 
Massachusetts General Hospital 
----------------------------------------------------------------- 
From: Mario Roederer <roederer@drmr.com> 
Date: Sun, Jun 21, 2009 at 4:01 PM 
Subject: Re: [Cytometry] CD150 negative population shifts down! How is 
this possible? 
To: Cytometry list <cytometry@flowcyt.cyto.purdue.edu> 
Hi Kat, 
I haven't seen your attached picture (it wasn't attached).... but I have a pretty good idea of 
what is going on.  We first noted this behavior some years ago, in the very early days of 
BD's digital electronics, and it hasn't gone away.  We've come to affectionately refer to it 
as the "baseline restore issue"...  While we are not positive that we understand what's 
going on, we have explored this issue a great deal, discussed it with BD and others, and 
think we have an explanation.  And we have at least 2 partial solutions: 
 
(1) Use additional washing steps of the cells after staining; and 
(2) Ignore the problem 
 

 



  

Details below! 
We originally saw this issue with QD655 staining (which is very bright, like PE). 
 However, we also began to see it occasionally with other reagents, but usually only those 
that are very bright.  We explored this issue quite a bit with a CD8 reagent (which is 
bright on cells). We found, first of all, that it didn't happen with all samples -- it seemed 
to be sample specific. (More on this later). 
Second, the extent to which the negatives crept down (towards more negative values) 
depended on the brightness of the reagent (use lower concentrations to lower the positive 
values, and the effect diminishes) as well as the frequency of the brightly-positive 
events(mix unstained cells with stained cells to varying extents, and the effect diminishes 
as well). 
Ultimately, I believe that what is going on is that the "baseline restore" on the instrument 
will sometimes over-estimate the background fluorescence.  Baseline restore is one 
process by which the instrument calculate the background of the stream as cells go 
through, in order to determine the actual fluorescence of the cell when it goes through. 
 Thus, as the background in the stream increases, the instrument subtracts more from the 
cell's fluorescence in order to get the actual cell-associated fluorescence. 
 
The background is estimated as the average fluorescence outside of any trigger events, 
over some recent time frame before the cell entered the laser. 
 
The problem with this approach is that if you have very bright clumps of fluorescence 
that go through the system without a trigger happening (because they don't have enough 
scatter signal, i.e., they are debris), this can artefactually increase the baseline 
dramatically.  The next cell that comes through will have WAY too much fluorescence 
subtracted from its measurement, and will go way negative. 
 
This hypothesis is supported by our observations:  diluting the sample with unstained 
cells will dilute the debris significantly, lowering the rate at which this happens.  Using 
less-brightly-staining reagents will to a large extent lower the fluorescence of any such 
debris/clumps, also diminishing the effect.  And finally, the problem tends to occur more 
with "dirty" reagents, for example, our early home-conjugated Quantum Dot reagents that 
have a lot of aggregates. 
 
We hypothesized that if this was an issue associated with debris, then additional cell-
washing steps following staining would reduce the problem -- and this is in fact the case. 
 So while there is no simple solution to avoid this problem entirely, if you add additional 
washing steps (particularly, low-spin steps that separate cells from debris), you will 
significantly reduce the incidence of this problem.  (That's partial solution number 1). 
 
Practically speaking, though, you can try to ignore it.  This issue never results in 
increased background -- so the background gates you establish on FMO's (or whatever 
control you have) are still valid, no matter how far below this gate the "negative" cells 
wander.  And while theoretically this problem can diminish the measured fluorescence of 
positive cells (and in fact we've seen that it does so), the diminution is fairly small and 

 



  

would only affect some dim cells – and given that the staining is very bright to see this 
problem at all, it probably isn't a real issue.  (That's partial solution number 2). 
 
Unfortunately, this does lead to some ugly displays, where the "negative" cells are far 
more negative than they should be.  There's nothing you can do about that, except to 
repeat the mantra that "all cells below measurable fluorescence are the same" -- i.e., there 
are no subpopulations of negative cells! 
regards, 
mr 
-------------------------------------------------------------------------------------- 

 

 



  

Repair Log 

 



  

 

Version Log: 
 
Version 2, released 9/1/11 


